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Copyright 

 

This manual, as well as the application it describes, are provided under license and 

may be used and copied only under the terms of the license. The content of this 

manual is rendered for informational use only and is subject to change without any 

notice. No part of this document may be reproduced or transmitted in any form, 

without prior permission from WeType4u. 

 

Supply of this product does not convey a license nor imply any right to distribute 

content created with this product in revenue-generating broadcast systems 

(terrestrial, satellite, cable and/or other distribution channels), streaming 

applications (via Internet, intranets and/or other networks), other content 

distribution systems (pay-audio or audio-on-demand applications and the like) or on 

physical media (compact discs, digital versatile discs, semiconductor chips, hard 

drives, memory cards and the like). An independent license for such use is required. 

For details, please visit http://mp3licensing.com.  

MPEG Layer-3 audio coding technology is licensed from Fraunhofer IIS and Thomson. 

 

Corporate Office: 

WeType4u 

106 East Chestnut Street 

Stillwater, MN  55082 

Telephone: (877) 938-9734 

 

Email: customerservice@wetype4u.com
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Introduction to Talk-N-Send 
 

Talk-N-Send is a desktop dictation application used to record audio files and upload 

them to WeType4u. It allows you to record your dictation in MP3 format using the 

simple user interface. The application permits you to: 

 

• Record audio file 

• Pause the recording 

• Playback the audio file 

• Rewind the audio file 

• Forward the audio file by five seconds 

• Go back by five seconds 

• Go to end of the audio file 

• Erase the audio file to the end 

• Save the audio file on the disk 

• Delete the audio file from the disk 

• View time elapsed and total duration of the audio file 

 

Every audio file that you record using Talk-N-Send has an information file associated 

with it. You can upload the audio files to the desired remote location. Talk-N-Send 

also allows you to upload audio files that you have recorded using some other 

dictation application. 

 

System Requirements 
 

You need to abide by the minimum system requirements to run the application 

effectively. 

Hardware Requirements 

The minimum hardware requirements are: 

 

• 32 MB of RAM 

• 16 bit full-duplex sound card 

• Unidirectional or omni directional microphone 

Software Requirements 

You should be using one of the following operating system: 

 

• Microsoft Windows 98 

• Microsoft Windows XP 

• Microsoft Windows Me 

• Microsoft Windows 2000 

• Microsoft Windows NT 

• Internet Explorer 5.0 or later version 
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Setting Internet Explorer: 

User has to follow following steps to configure IE. 

1. Go to the Tools Menu of IE and clicks on Internet Options. 

 

 
 

 

2. After Clicking on Internet option the following screen will be display and click 

on security Tab. 
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3. After Clicking on security Tab the following screen will be display and select 

Internet Option than click on Custom Level. 

 

 
 

4. By Clicking on Custom Level button following screen will be display. 
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5. Go to option “In ActiveX Controls and plug-ins” � “ Initialize and script 

ActiveX Controls not marked as safe….” � select the Enable Option. 

Go to “Reset Custom Settings” � “Reset to” � select the “Medium” from drop 

down and than click on “Ok” button. BY clicking on Ok Button the following 

Warning Message will be display and user has to click on “ Yes” Button 

 

 
 

 

6. Now click on “OK” Button in step 3 Screen. Now the IE Is ready to upload 

Liles and Receive status on client machine. 

7.  

 

Note: Talk-N-Send is not available for Macintosh at this time. Refer to installation 

manual for detailed information. 

 



Talk-N-Send  User Manual 

WeType4u                                                          9  
   

Getting Started 
 

When you use the application for the first time, the application will prompt you to 

register the software. The application will also run an audio tuning wizard and 

prompt you to enter user information and upload preferences. 

 

Note: You must connect to the Internet if you wish to register your copy of Talk-N-

Send application. 

License Key Administrator Wizard 
 

When you run the application for the first time, you will see a screen similar to the 

one shown below.  

 

            
 

 

If you have received a Talk-N-Send License Key, enter the License Key to get your 

copy registered otherwise to get a License Key, please email at 

customerservice@wetype4u.com or call 1-877-WETYPE4U (1-877-938-9734).  

 

If you click on r4egister button you will see a screen similar to one shown below. 
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Enter the “License Key”. If you are behind a firewall or using a proxy server to 

connect to the Internet, select “Named Proxy” and enter the proxy server “Address” 

and “Port”. Click on “OK” to submit the information. This will complete the 

registration. 
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Audio Tuning Wizard 
 

Double click on the Talk-N-Send shortcut on your desktop to start the application. 

You will see the screen similar to the one shown here. This is the Audio Tuning 

Wizard, which tunes the audio settings of the computer and checks for proper 

connection of microphone, headphones, or speakers to the computer.  

 

 

 

 

 

 

Click on the “Next” button, or press “Alt” + “N” keys on the keyboard to proceed. 

The next screen will check the microphone connected to your computer.  
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Click on the “Record” button and speak into your microphone to check the 

functioning. You can record a maximum of 15 seconds of audio. Click on the “Next” 

button to proceed. You can go back to the previous screen by clicking on the “Back” 

button, or using the “Alt” + “B” key combination.     

 

The next screen will check the speakers or headphones connected to your computer. 
 

 

 

Click on the “Play” button and you will hear the audio you had recorded on the 

previous screen. Click on “Finish” button, or press “Alt” + “F” keys on the keyboard 

to exit the Audio Tuning Wizard. 
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Settings 
 

After you exit the Audio Tuning Wizard, you will see “Settings” screen similar to the 

one shown here. It allows you to customize the application settings. The fields  

marked * are mandatory. The detailed explanation of all the fields follows: 

 

 

Shared Location for MP3 File 

Enter the location of the folder where you wish to store the job (MP3) files. Click on the “Browse” 
button to specify the path of the shared file path. 
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To create a new folder, select the “New Folder” button and type the name of the folder as shown 
in figure below. 

 
 
Click the “OK” button to save the shared file folder location. 
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WeType4u Customer Information (Default Values) 

Account Number 

This is a ten digit WeType4u Account Number that you want to associate with the 

job. 

Template Number 

This is a Template Number that you want to associate with the job. 

Job Priority 

This is the Job Priority that you want to associate with the job. 

 

If you leave Template Number or Job Priority blank they will be reset to their default 

values. The default values for these three fields will be displayed in the “Upload 

file(s)” screen, invoked by pressing the “Submit” button on the main interface, when 

you first select a file to create its information file. 

Login  

Enter the login name to connect to the FTP server 

Password 

Enter the password to connect to the FTP server 

 

If you leave all three “FTP Settings” fields blank, the application will set the values to 

default. However, you may not enter values in only one or two fields. You must enter 

values of all the fields. 

Proxy/Firewall Settings 

You must specify whether you wish to connect to the Internet directly or using a 

proxy server. 

No Proxy 

If you connect to the Internet directly, using modem, lease line, or cable connection 

then select this option. You can select the option by clicking on the radio button next 

to the “No Proxy” label. This is the default selection. 

Named Proxy 

If you connect to the Internet using a proxy server or if you are behind a firewall 

then select “Named Proxy” by clicking on the radio button. In this case, you must 

specify the following information. 

 

• Address: You can specify the name of the proxy server, or you can enter the 

IP address of the proxy server. For entering the IP address, select the “IP 

Address” check box. 

• FTP Port: Enter the port number of the proxy server for FTP service. 
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Customize 

This allows you to customize the behavior of the application. You can select any or all 

of the three given options by clicking on the check box to the left of the text. 

 

• Show User Information at startup: displays the user information every time 

you start the application. 

• Allow the program to run in the background: allows the application to always 

run in the background. You will see an icon representing the running 

application in the system tray. 

• Run Audio Tuning Wizard when Talk-N-Send starts: runs the Audio Tuning 

Wizard every time you start the application. 

 

 

After filling up all the fields, you can click on the “OK” button to save the information. 

You can click on the “Cancel” button at any time, to close the screen without saving 

the information. You can click on the “Default” button to retrieve the default values 

of the “FTP Destination”, “HTTP Destination”, and “Proxy/Firewall Settings”. 
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Understanding the Work Area 
 

The user interface of the application is seen below: 

 

 

  
 

You have all the functionality to capture audio that you would have if using a 

conventional hand held recorder. The application allows you to record a new audio 

file, modify an existing audio file, listen, and upload an audio file. 

 

Viewing Status 
 

There are two methods for viewing the status of your dictation. 
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Color System 

You can observe the status of the dictation by the colors that flash on the top left 

corner of the application. Each color indicates a specific mode, in which the 

application is at that moment. 

Represents recording mode 

Represents standby mode 

Represents playing mode 

 

Volume Control 

You can adjust the volume of recording and playing by using this control on the top 

right of the application. You can click on “+” button to increase and “-” button to 

decrease the volume. The volume control manipulates the microphone volume in the 

recording mode and the speaker volume when in playing mode. 

Display System 

You can also read the status information in the text area displayed under the color 

flash. You will see three types of information in this area. The top most row displays 

the name of the audio file that is currently open. The middle row displays the time 

elapsed/total time of the audio file. The last row displays the status of the dictation. 

You can learn about the different status of the application in the following section.             

Using the “Red” Buttons 
  

The different buttons, which allow you to work with the dictation application, are: 

New File 

You can start a new dictation by clicking on this button. The application automatically 

assigns a name to the file. If you do not specify the Account Number in the settings 

screen, the file name will be in the MMDDYYhhmmss format, otherwise the file name 

is in Account Number_ MMDDYYhhmmss format. You have to click on the “Record” 

button to begin the recording. 

 

Following is the naming convention used for the file names: 

MM -> Month 

DD-> Day 

YY-> Year 

hh-> Hour 

mm-> Minute 

ss-> Second 

Account Number-> This is the Account Number specified in the “Settings” screen 

Open Existing 

You can open an existing audio file recorded using Talk-N-Send by clicking on this 

button. You can browse through your disk and select any job (MP3) file.  
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Save File 

You can save the audio file by clicking on this button. It will open the “Job Details” 

screen as seen below, and you will have to enter the details of the audio file you 

want to save. The fields marked * are mandatory. 

 

 

 

 
 

 

• File Path: This will display the path of the shared file location, where the 

dictation will be saved. This is the same path that you specified in “Shared 

Location for MP3 File” in the ”Settings” screen. 

 

• File Name: The application will generate a name for the job by default. You 

can modify this name to any unique filename you prefer. 

 

 

Click on “OK” button to save the audio file or click on the “Cancel” button to go back 

to the main interface without saving the file.  

Exit 

You can exit the application by clicking on this button. It will ask you to confirm your 

wish to exit, click on “Yes” to quit the application. 

Using the “Blue” Number Pad 

Pause (1) 

Click on this button to pause the recording in progress. You can also use this button 

to pause the playing of the audio file. It is not possible to manipulate the audio file in 

this mode and you must click on the “Resume” button to proceed. You can also 

invoke this function by pressing the shortcut key “1” on the keyboard. You can 

observe the status in the display area on the top. 

Record (2) 

Click on this button to start recording the audio file. You can also begin recording by 

pressing the shortcut key “2” on the keyboard. You can observe the status in the 

display area on the top. 
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Rewind (3) 

You can rewind the audio file by clicking on this button. You cannot use this function 

when the recording is in progress. The shortcut key “3” on the keyboard can also be 

used to rewind the file. You can observe the status in the display area on the top. 

Go to End (4) 

You can click on this button to move to the end of the audio. This is useful when you 

wish to append to an already existing audio file. You can also invoke this function by 

pressing the shortcut key “4” on the keyboard. You can observe the status in the 

display area on the top. 

Stop (5) 

You can stop the recording or playing of the audio file by clicking on this button. You 

can also do the same by pressing the shortcut key “5” on the keyboard. You can 

observe the status in the display area on the top. 

Go Fwd 5 Sec. (6) 

You can advance the audio file by five seconds by clicking on this button. You can 

also invoke this function by pressing the shortcut key “6” on the keyboard. You can 

observe the status in the display area on the top. 

Replay (7) 

You can replay the audio file by clicking on this button. This is a useful feature when 

you wish to review the recording. You can also invoke this by pressing the shortcut 

key “7” on the keyboard. You can observe the status in the display area on the top. 

New File (8) 

You can start a new dictation by clicking on this button. The application automatically 

assigns a name to the file. If you do not specify the Account Number in the settings 

screen, the file name will be in the MMDDYYhhmmss format, otherwise the file name 

is in Account Number_ MMDDYYhhmmss format. You have to click on the “Record” 

button to begin the recording. The same can also be done by pressing the shortcut 

key “8” on the keyboard. 

Go Back 5 Sec (9) 

You can move back the audio file by five seconds by clicking on this button. The 

same can also be done by pressing the shortcut key “9” on the keyboard. You can 

observe the status in the display area on the top. 

Delete (*) 

You can delete the audio file permanently from the hard disk by clicking on this 

button. It will open a screen similar to the one seen below. 
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You will see a list of all the existing job (MP3) files located in your Shared File folder 

in the list box on the left. You can select the files you wish to delete. Click on the 

“Delete From Disk” button to remove the files. You can select all the files listed on 

the left by clicking on the “Select All” check box. Click on the “Cancel” button to close 

the screen without deleting any file. You can use the same feature by pressing the 

shortcut key “Delete” or “Shift”+ “*” on the keyboard. 

 

Erase to End (0) 

You can erase the audio from the job (MP3) file by clicking on this button. 

Remember, this will not delete the file from the hard disk, but remove the contents 

of the file from the current point onwards. The modification will take effect when you 

save the job file. You cannot use this feature in the recording mode. You can use the 

same feature by pressing the shortcut key “0” on the keyboard. You can observe the 

status in the display area on the top. 

 

Submit (#)  

You can submit an audio file for dictation by clicking on this button. It will open the 

screen seen below. Select a file from the list of files displayed under “Attached Files”. 

You can click on the “Select All” check box to select all the files displayed in the list. 
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If you have created the selected job file using Talk-N-Send application, then you will 

see the following information about the selected file: 

  

• Account Number: This field will contain the ten-digit WeType4u account 

number. By default, the value for this field will be same as specified in the 

“Settings” screen. 

 

• Template Number: This is the number of the template that you want to 

associate with the job. It can take a maximum of ten digits. By default, the 

value for this field will be same as specified in the “Settings” screen. 

 

• Job Priority: This will show the selection of one of the given values used to 

assign a priority to the job. By default, the value for this field will be same as 

specified in the “Settings” screen. 

 

• Description: This field will contain the description of the file to be uploaded. 

 

You must enter the values in these fields to create the information file corresponding 

to the job file.  

 

To send an audio file that you have created using some other dictation application, 

click on the “Browse” button to choose the file, and then click “OK”. Select the file 

from the “Attached Files” list (the job detail fields mentioned above will be blank). 
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Enter your Account Number, Template Number, and select a Job Priority. Click on 

“Update” button to create/update the information file. Click on “FTP”, or “HTTP” 

button to upload the Job file. 

 

To change the job details for an audio file you want to submit, select the file(s), and 

then edit the information present in these fields.  

 

You can submit the audio file by using one of the following methods: 

FTP 

You can upload a job file using FTP only if it has an information file associated with it. 

When you upload the job file, the application will also upload the associated 

information file. In addition, the application will move the uploaded files to the 

“Uploaded” folder in the “Shared Location for MP3 File”. You can upload files to the 

FTP server by clicking on “FTP” button. You can choose to cancel the upload process 

by clicking on “Cancel” button. The FTP destination information you enter in the 

“Settings” screen will be used to logon to the FTP server.  

 
HTTPS 

Users can upload a job file using HTTPS by clicking on this button. The default 

browser is used to display the interface for selecting and uploading files. 
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Browse button: Select the file by browse button. User can browse for any file on 

the hard drive or any networked drive. The selected file will be displayed in text box. 

 

Close Button: This button is used to close the currently display window. Before 

closing window it will ask user confirmation. 

Navigating the Menu 
 

File 

You can invoke the following functions from the “File” menu. You can also invoke this 

by pressing the shortcut key “Alt” + “F” on the keyboard. 

New 

You can start a new dictation by clicking on “New”. You have to click on the “Record” 

button to begin the recording. You can also invoke this function by pressing the 

shortcut key “Alt” + “F” + “N” on the keyboard. 

Open 

You can open an existing audio file recorded using Talk-N-Send by clicking on 

“Open”. You can browse through your disk and select any job (MP3) file. You can 

also invoke this function by pressing the shortcut key “Alt” + “F” + “O” on the 

keyboard. 

Save 

You can save the audio file by clicking on “Save”. It will open the “Job Details” screen 

described in the previous section. You can also invoke this function by pressing the 

shortcut key “Alt” + “F” + “S” on the keyboard. 

Submit 

You can submit an audio file for dictation by clicking on “Submit”. It will open the 

“Upload file(s)” screen described in the previous section. You can also invoke this 

function by pressing the shortcut key “Alt” + “F” + “B” on the keyboard. 

Exit 

You can exit the application by clicking on “Exit”. It will ask you to confirm your wish 

to exit, click on “Yes” to quit the application. You can also invoke this function by 

pressing the shortcut key “Alt” + “F” + “X” on the keyboard. 

Options 

You can invoke the following functions from the “Options” menu. You can also invoke 

this by pressing the shortcut key “Alt” + “P” on the keyboard. 

 

Settings 

You can customize the application settings by clicking on “Settings”. This will open 

the “Settings” screen described in the previous section. You can also invoke this 

function by pressing the shortcut key “Alt” + “P” + “E” on the keyboard. 
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Register Talk-N-Send 

You can click on “Register Talk-N-Send” to get your copy of the application 

registered with WeType4u. This will open the License Key Administrator Wizard, 

which will guide you through the steps to register Talk-N-Send. You can also invoke 

this function by pressing the shortcut key “Alt” + “P” + “R” on the keyboard. 

 

WeType4u Sign-up 

You can click on “WeType4u Sign-up” to become a WeType4u member. It will open 

the Wetype4u signup page in your web browser. You can also invoke this function by 

pressing the shortcut key “Alt” + “P” + “S” on the keyboard. 

 

Help 

You can invoke the following information from the “Help” menu. You can also invoke 

this by pressing the shortcut key “Alt” + “H” on the keyboard. 

 

Help Topics 

You can view the Talk-N-Send help at any point by clicking on “Help Topics”. You can 

also invoke this function by pressing the shortcut key “Alt” + “H” + “H” on the 

keyboard. 

WeType4u Home Page 

You can visit the WeType4u web site by clicking on “WeType4u Home Page”. You can 

also invoke this function by pressing the shortcut key “Alt” + “H” + “W” on the 

keyboard. 

About Talk-N-Send 

You can view the information about Talk-N-Send application by clicking on “About 

Talk-N-Send”. You can also invoke this function by pressing the shortcut key “Alt” + 

“H” + “T” on the keyboard. 

About LAME 

You can find out about the LAME project by clicking on “About LAME”. It will show 

you the agreement for the use of decoder functions in Talk-N-Send application. You 

can also visit the web site www.mp3dev.org to learn more about LAME. You can also 

invoke this function by pressing the shortcut key “Alt” + “H” + “M” on the keyboard. 
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Recording an Audio File 
 

You can either record a new audio file or modify an existing audio file. 

Record a New File 
To record a new audio file, you must follow these steps: 

 

1. Click on the “New File” button 

2. Click on the “Record” button 

3. Speak into the microphone 

4. Click on the “Stop” button when you wish to end recording 

5. Click on the “Save File” button to save the audio file on the disk 

 

Modify an Existing File 
To modify an audio file previously recorded using Talk-N-Send, you must follow 

these steps: 

 

1. Click on the “Open Existing” button 

2. Select the file you wish to overwrite and click on the “Open” button 

 

This will play the file. If you wish to overwrite the complete file, follow these steps: 

 

1. Click on the “Record” button 

2. Speak into the microphone 

3. Click on the “Stop” button when you wish to end recording 

4. Click on the “Save File” button to save the audio file on the disk 

 

If you wish to rewrite some portion of the file, play the audio file. When you reach 

the point from where you wish to modify, follow the above-mentioned steps. 

 

If you wish to append to the existing file, follow these steps: 

 

1. Click on the “Go to End” button 

2. Click on the “Record” button 

3. Speak into the microphone 

4. Click on the “Stop” button when you wish to end recording 

5. Click on the “Save File” to save the audio file on the disk 

 

The other method to append the file is: 

 

1.  Click on the “Open Existing” button 

2. Select the file you wish to modify and click on the “Open” button 

 

This will play the file. To append to the existing file, follow these steps: 

 

1. Wait until the file reaches the end 

2. Click on the “Record” button 
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3. It will ask you whether you wish to append the file. Click on “Yes” 

4. Speak into the microphone 

5. Click on the “Stop” button when you wish to end recording 

6. Click on the “Save File” to save the audio file on the disk 

 

Playing an Audio File 
 

If you wish to listen to an audio file that you recorded previously, click on the “Open 

Existing” button, select the file you wish to play, and click on the “Open” button. You 

can rewind, forward, and pause the audio file. 

 

Submit an Audio File 
 

To submit the job you have to click on the “Submit” button. It will open the “Submit” 

screen described earlier. 

 

Note: The Talk-N-Send application creates some internal and temporary files. Make 

sure you do not tamper with the internal files of the application. 

 

Confirmation of Job Receipt 
 

After you have submitted the job file to Wetype4u and it has been loaded into our 

system, you will receive a confirmation E-Mail with your filename, template, and turn 

around time you selected, along with the corresponding Wetype4u Job Number. Keep 

this number for future reference. If the information is not correct, please contact us 

immediately at 1-877-WETYPE4U (1-877-938-9734). 
 

 


